
Issues

# Project Tracker Status Priority Subject Assignee Updated

1589 BMP App Beta Version Bug New High Search bar auto-focused in destination chain dropdown causing unwanted

keyboard popup

Muhammad 

Shahid

04/10/2026 01:22 PM

1588 BMP App Beta Version Bug New High Incorrect currency icons displayed (all currencies showing dollar sign) Muhammad 

Shahid

04/10/2026 01:15 PM

1587 BMP App Beta Version Bug New Normal Search bar auto-focused in currency dropdown causing keyboard to open

automatically

Muhammad 

Shahid

04/10/2026 01:15 PM

1586 BMP App Beta Version Bug New Normal Invalid phone number error shown after OTP verification despite valid input Muhammad 

Shahid

04/10/2026 12:22 PM

1585 BMP App Beta Version Bug New Normal Screen shifts upward when opening country number selection dropdown Muhammad 

Shahid

04/10/2026 12:02 PM

1583 BMP App Beta Version Bug New Normal New message indicator (arrow) overlapping typing bar and lacking

visibility/count

Muhammad 

Shahid

04/10/2026 11:04 AM

1582 BMP App Beta Version Bug New High Call status labels not showing correct states (missed, ongoing, ended with

duration)

Muhammad 

Shahid

04/10/2026 10:42 AM

1580 BMP App Beta Version Bug New Normal Call not ending on receiver device after being ended on caller device(Unsual) Muhammad 

Shahid

04/10/2026 09:47 AM

1579 BMP App Beta Version Bug New Normal Missed call count not displayed on calls icon Muhammad 

Shahid

04/10/2026 07:33 AM

1578 BMP App Beta Version Bug New Normal Missed call notification count increments incorrectly (adds 3 instead of 1) Muhammad 

Shahid

04/10/2026 07:16 AM

1577 BMP App Beta Version Bug New Normal Unread message count popup shows incorrect color (pink instead of blue) Muhammad 

Shahid

04/10/2026 10:49 AM

1576 BMP App Beta Version Bug New High Incorrect user profile icon shown in typing indicator Muhammad 

Shahid

04/10/2026 10:50 AM

1575 BMP App Beta Version Bug New Normal Incorrect profile icon shown under last message after it is read Muhammad 

Shahid

04/10/2026 06:52 AM

1574 BMP App Beta Version Bug New Normal Message read status not updating correctly Muhammad 

Shahid

04/10/2026 06:33 AM

1573 BMP App Beta Version Bug New Normal Invitation link does not contain updated APK link Muhammad 

Shahid

04/10/2026 10:50 AM

1572 BMP App Beta Version Bug New Normal Back button not working after unarchiving chat from Archive folder Muhammad 

Shahid

04/10/2026 06:06 AM

1571 BMP Web App Task New Normal Video Call – Group (Component-Based) Talha Ali 04/10/2026 05:19 AM

1570 BMP Web App Task New Normal Video Call (Single) — Component-Based Single Screen Talha Ali 04/10/2026 05:14 AM

1569 BMP Web App Task New Normal Single Voice Call – Incoming (Both Sections) Talha Ali 04/10/2026 05:14 AM

1568 BMP Web App Task New Normal Voice Call (Single Screen Handling with States) Talha Ali 04/10/2026 05:19 AM

1567 BMP Web App User Story New Normal Voice & Video Call (Single + Group) Talha Ali 04/10/2026 05:17 AM
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1566 BMP Web App Task New Normal Create New Chat – Group Info (Step 2 + Done Handling via Component) Talha Ali 04/10/2026 05:12 AM

1565 BMP Web App Task New Normal Create New Chat – Group Info (Step 1) Talha Ali 04/10/2026 05:12 AM

1564 BMP Web App Task New Normal Create New Chat – Group (Select Members) Talha Ali 04/10/2026 05:10 AM

1563 BMP Web App User Story New Normal Create New Group Chat Talha Ali 04/10/2026 05:17 AM

1562 BMP Web App Task New Normal Personal Chat Story View – Type Screen (2h) Talha Ali 04/10/2026 04:53 AM

1561 BMP Web App Task New Normal Personal Chat Story View Talha Ali 04/10/2026 04:53 AM

1560 BMP Web App Task New Normal View Story / My Story – View Talha Ali 04/10/2026 04:52 AM

1559 BMP Web App Task New Normal My Story – Create & Edit (Image Tools) Talha Ali 04/10/2026 04:52 AM

1558 BMP Web App Task New Normal Add Story Talha Ali 04/10/2026 04:51 AM

1557 BMP Web App User Story New Normal Story Section Talha Ali 04/10/2026 04:53 AM

1554 BMP App Beta Version Bug New High Deleting one blocked user removes two users from block list Muhammad 

Shahid

04/10/2026 10:48 AM

1551 BMP App Beta Version Bug New Normal App navigates to Menu Screen instead of User Screen after returning from

Blank Screen

Muhammad 

Shahid

04/09/2026 12:58 PM

1544 BMP App Beta Version Bug New Normal Blocked Users Screen Occasionally Displays Blank Screen Muhammad 

Shahid

04/09/2026 12:24 PM

1542 BMP App Beta Version Bug New High Read Action Icon Not Opening Chat on Swipe Gesture in Chat Screen Muhammad 

Shahid

04/09/2026 10:17 AM

1541 BMP Web App Task New Normal Group Chat Attachments (Send Docs) Talha Ali 04/09/2026 09:04 AM

1540 BMP Web App Task New Normal Group Chat Messaging Features Talha Ali 04/09/2026 09:03 AM

1539 BMP Web App Task New Normal Group Chat Header Talha Ali 04/09/2026 09:03 AM

1538 BMP Web App Task New Normal Group Chat Layout Talha Ali 04/09/2026 09:02 AM

1537 BMP Web App User Story New Normal Group Chat Detail & Send Docs Talha Ali 04/09/2026 09:04 AM

1536 BMP Web App Task New Normal Camera Capture (Photo & Video) Talha Ali 04/09/2026 08:59 AM

1535 BMP Web App Task New Normal Contact Sharing Talha Ali 04/09/2026 08:59 AM

1534 BMP Web App Task New Normal Location Sharing Talha Ali 04/09/2026 08:58 AM

1533 BMP Web App Task New Normal Document Sharing Talha Ali 04/09/2026 08:58 AM

1532 BMP Web App Task New Normal Attachment Gallery & Media Sharing Talha Ali 04/09/2026 08:55 AM

1531 BMP Web App User Story New Normal Personal Chat Detail (Send Docs) Talha Ali 04/09/2026 09:00 AM

1530 BMP Web App Task New Normal Voice Message Recording & Sending Talha Ali 04/09/2026 08:46 AM

1529 BMP Web App Task New Normal Pinned Messages & Typing Interaction Talha Ali 04/09/2026 08:45 AM

1528 BMP Web App Task New Normal Message Selection & More Options Talha Ali 04/09/2026 08:43 AM

1527 BMP Web App Task New Normal Personal Chat Layout & Chat Detail UI Talha Ali 04/09/2026 08:42 AM

1526 BMP Web App User Story New Normal Personal Chat Detail Talha Ali 04/09/2026 08:47 AM
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1525 BMP Web App Task New Normal Process and Done Screens Talha Ali 04/09/2026 07:59 AM

1524 BMP Web App Task New Normal Add New Contact Talha Ali 04/09/2026 07:59 AM

1523 BMP Web App Task New Normal Contacts & All Contacts – Search & Empty Screens Talha Ali 04/09/2026 07:58 AM

1522 BMP Web App Task New Normal Create New Chat Talha Ali 04/09/2026 07:58 AM

1521 BMP Web App Task New Normal All Chats – Empty Screen Talha Ali 04/09/2026 07:58 AM

1520 BMP Web App User Story New Normal New Chat Talha Ali 04/09/2026 07:59 AM

1519 BMP Web App Task New Normal Calls List – Call History Talha Ali 04/09/2026 07:50 AM

1518 BMP Web App Task New Normal Search – Chat & Contact Talha Ali 04/09/2026 08:01 AM

1517 BMP Web App User Story New Normal Search and Call History Talha Ali 04/09/2026 08:00 AM

1516 BMP Web App Task New Normal Group Chats UI Talha Ali 04/09/2026 07:16 AM

1515 BMP Web App Task New Normal Unread Chats View Talha Ali 04/09/2026 07:14 AM

1514 BMP Web App Task New Normal Chat List Filtering Talha Ali 04/09/2026 07:13 AM

1513 BMP Web App Task New Normal All Chats – Multiple Selection Talha Ali 04/10/2026 07:36 AM

1512 BMP Web App Task New Normal All Chats – Single Selection Talha Ali 04/09/2026 08:01 AM

1511 BMP Web App Task New Normal All Chats – Swipe Read Interaction Talha Ali 04/09/2026 07:18 AM

1510 BMP Web App Task New Normal All Chats – Empty State UI Talha Ali 04/09/2026 07:17 AM

1509 BMP App Beta Version Bug New High Menu Tabs Missing Drop Shadow and Showing Blur Edge Artifacts Muhammad 

Shahid

04/09/2026 07:09 AM

1508 BMP Web App User Story New Normal Chat Module – Chat History UI Development Talha Ali 04/09/2026 08:01 AM

1507 BMP App Beta Version Bug New Normal Menu Tab Arrangement Mismatch with Figma Muhammad 

Shahid

04/09/2026 06:55 AM

1506 BMP Web App Epic New Normal Chat Module UI Development Talha Ali 04/10/2026 05:17 AM

1505 BMP Web App Task New Normal Rebuild / Refactor UI to Fix Issues (Follow Figma) Muhammad  Fahad 04/10/2026 01:41 PM

1504 BMP Web App Task New Normal Implement Custom Components Following Figma Designs Talha Ali 04/10/2026 09:10 AM

1503 BMP Web App Bug Resolved Normal Implement Proper Navigation Flow and Route Naming Across Project Muhammad  Fahad 04/10/2026 12:48 PM

1502 BMP App Beta Version Bug New Normal Clear (Cross) Icon Incorrectly Displayed in Name and Email Fields on Create

Account Screen

Muhammad 

Shahid

04/09/2026 06:15 AM

1501 BMP Web App Task Resolved Urgent Implement Custom Gradient Backgrounds Across UI Muhammad Talha 04/10/2026 05:22 AM

1500 BMP Web App Task New Normal PayCrypto KYC Screens Muhammad Talha 04/09/2026 06:27 AM

1499 BMP Web App Task New Normal Dashboard - KYC Verification - Government ID Muhammad Talha 04/09/2026 09:06 AM

1498 BMP Web App Task New Normal Personal Information Screen Muhammad Talha 04/09/2026 09:05 AM

1497 BMP Web App Task New Normal Welcome External Account Screen Muhammad Talha 04/09/2026 09:05 AM

1496 BMP Web App Epic New Immediate Finance Module UI Development Muhammad Talha 04/10/2026 01:41 PM
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1495 Prism Release 2 Bug Resolved Normal Donut Chart – Visual and General Issues in Arabic & English UI mirza asad 04/09/2026 01:05 PM

1492 BMP App Beta Version Bug New High Email verification toggle is not showing in case of email Muhammad 

Shahid

04/08/2026 01:40 PM

1491 BMP App Beta Version Bug New High Incorrect Text Formatting in Logout Confirmation Dialog Muhammad 

Shahid

04/08/2026 01:30 PM

1490 BMP App Beta Version Bug New High Incorrect and Misleading Instruction Text on Email Login Screen Muhammad 

Shahid

04/08/2026 01:30 PM

1489 BMP App Beta Version Bug New Normal Popup Background Transparency Issue Causing Text Overlap on Verification

Screen

Muhammad 

Shahid

04/08/2026 12:49 PM

1488 Admin Panel (BMP) Bug New Normal User is able to log in after multiple attempts with invalid password. Talha Ali 04/08/2026 12:32 PM

1487 Admin Panel (BMP) Bug New Normal Error messages displayed under fields instead of toast on Login Page. Talha Ali 04/08/2026 12:24 PM

1486 Admin Panel (BMP) Bug New High White screen appears when clicking on User from Dashboard Talha Ali 04/08/2026 12:20 PM

1485 Admin Panel (BMP) Bug New High System alert icons missing on Dashboard as per design. Talha Ali 04/08/2026 12:11 PM

1484 Admin Panel (BMP) Bug New Normal Text alignment issue in Password Reset instructions. Talha Ali 04/08/2026 12:05 PM

1483 Admin Panel (BMP) Bug New Normal Text wrapping issue on Password Reset page (text moves to next line) Talha Ali 04/08/2026 11:54 AM

1482 Admin Panel (BMP) Bug New Normal Excessive spacing in Email and Password fields on Login Page Talha Ali 04/08/2026 11:50 AM

1480 BMP App Beta Version Bug New High Session Expired Error Persists After OTP Resend on Verification Screen Muhammad 

Shahid

04/09/2026 07:00 AM

1479 Admin Panel (BMP) Bug New Normal Incorrect spacing in brand name "Be-mindpower" on UI Talha Ali 04/08/2026 11:38 AM

1478 Admin Panel (BMP) Bug New Normal Login Page UI color design mismatch with design specifications Talha Ali 04/08/2026 11:23 AM

1477 BMP App Beta Version Bug New Low Keyboard “Next” Button Does Not Move Cursor to Phone Field on Create

Account Screen

Muhammad 

Shahid

04/08/2026 11:02 AM

1476 BMP App Beta Version Bug New High Create Account Allows Navigation to Verification Screen with Invalid Phone

Number

Muhammad 

Shahid

04/08/2026 11:41 AM

1475 BMP App Beta Version Bug New High Clipboard “Done” Action Triggers Unintended Continue Button Click Muhammad 

Shahid

04/08/2026 10:42 AM

1474 BMP App Beta Version Bug New Normal Phone Number Field Not Reset When Switching Login Methods Muhammad 

Shahid

04/08/2026 10:53 AM

1473 BMP App Beta Version Bug New Normal Missing Validation for Invalid Phone Number Format on Login Muhammad 

Shahid

04/08/2026 10:52 AM

1472 Prism Release 2 Bug New Normal select tool issue Ghulam Mustafa 04/08/2026 08:01 AM

1471 Prism Release 2 Bug Resolved Normal issue in generate row tool mirza asad 04/09/2026 01:06 PM

1469 BMP Web App Bug Resolved Immediate Convert PNG Icons to Next.js Built-in / SVG Icons Talha Ali 04/10/2026 09:10 AM

1468 Prism Release 2 Bug Resolved Normal Pie Chart – Visual and General Issues in Arabic & English UI mirza asad 04/09/2026 01:05 PM

1457 Prism Release 2 Bug Resolved Normal Summarize Tool State issue ALi RAZA 04/07/2026 12:37 PM

1456 Prism Release 2 Bug Ready For QA Normal Summarize Tool issue Ghulam Mustafa 04/08/2026 11:28 AM
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1455 Prism Release 2 Bug Ready For QA Normal imputation tool issue Ghulam Mustafa 04/08/2026 11:28 AM

1454 Prism Release 2 Bug Ready For QA Normal imputation tool issue Ghulam Mustafa 04/08/2026 11:28 AM

1453 Prism Release 2 Bug Resolved Normal Input Tool - Header Options issue ALi RAZA 04/07/2026 10:12 AM

1451 Prism Release 2 Bug Ready For QA Normal Canvas Setting issue in sizes mirza asad 04/07/2026 06:30 AM

1450 Prism Release 2 Bug Ready For QA Normal Summarize Tool aggregation function issue ALi RAZA 04/07/2026 06:30 AM

1449 Prism Release 2 Bug Ready For QA Normal Cross Tab Tool Issue Ghulam Mustafa 04/08/2026 11:28 AM

1448 Prism Release 2 Bug Resolved Normal Transpose Tool Output issue ALi RAZA 04/07/2026 10:42 AM

1446 Prism Release 2 Bug Ready For QA Normal Card Visual – General Issues in Arabic & English UI ALi RAZA 04/07/2026 06:30 AM

1445 Prism Release 2 Bug Resolved Normal Need to check the Transform category and fix the issues ALi RAZA 04/09/2026 12:48 PM

1444 Prism Release 2 Bug Ready For QA Normal When user send the multi outputs tool to the visualization so need to handled

them correctly right now these are not working as expected

mirza asad 04/07/2026 06:30 AM

1443 Prism Release 2 Bug Ready For QA Normal Cell Viewer also is not working mirza asad 04/07/2026 06:30 AM

1442 Prism Release 2 Bug Ready For QA Normal All the tools should auto sent to visualization ALi RAZA 04/07/2026 06:30 AM

1441 Prism Release 2 Bug Ready For QA Normal Line and Stacked Column - Visualization mirza asad 04/07/2026 06:30 AM

1440 Prism Release 2 Bug Ready For QA Normal Scatter Trend Line Chart – Visual and General Issues in Arabic & English UI mirza asad 04/07/2026 06:30 AM

1439 Prism Release 2 Bug Ready For QA Normal Stacked Bar Chart ALi RAZA 04/07/2026 06:30 AM

1436 Prism Release 2 Bug Ready For QA Normal Focus Mode - Visualization ALi RAZA 04/07/2026 06:30 AM

1435 Prism Release 2 Bug Ready For QA Normal Union Tool - Analytics ALi RAZA 04/07/2026 06:30 AM

1434 Prism Release 2 Bug Todo Normal Unnecessary POST request to categories API ALi RAZA 04/01/2026 12:24 PM

1431 Admin Panel (BMP) Feature New Normal send notification page Talha Ali 03/30/2026 12:19 PM

1430 Admin Panel (BMP) Feature New Normal add user page Talha Ali 03/30/2026 12:19 PM

1429 Admin Panel (BMP) Feature New Normal reset password page Talha Ali 03/30/2026 12:18 PM

1428 Admin Panel (BMP) Feature New Normal login page Talha Ali 03/30/2026 12:18 PM

1427 Admin Panel (BMP) Feature In Progress Normal notification system backend apis Abdullah Sajjad 03/31/2026 01:26 PM

1426 Admin Panel (BMP) Feature Resolved Normal add user - backend api Abdullah Sajjad 03/31/2026 01:26 PM

1425 Admin Panel (BMP) Feature Resolved Normal reset password Abdullah Sajjad 03/31/2026 01:26 PM

1424 Admin Panel (BMP) Feature Resolved Normal login system admin Abdullah Sajjad 03/31/2026 01:26 PM

1423 Prism Release 2 Bug Ready For QA Normal Bubble 3D Chart – Visual and General Issues in Arabic & English UI ALi RAZA 04/07/2026 06:30 AM

1422 Prism Release 2 Bug Ready For QA Normal Bubble/Scatter Chart – Visual and General Issues in Arabic & English UI ALi RAZA 04/07/2026 06:30 AM

1421 Prism Release 2 Bug Ready For QA Normal Fields data isnt reflected under columns charts data ALi RAZA 04/07/2026 06:30 AM

1420 Prism Release 2 Bug Ready For QA Normal bubble issuse mirza asad 04/07/2026 06:30 AM

1419 Prism Release 2 Bug Ready For QA Normal line chart issuse mirza asad 04/07/2026 06:30 AM

1418 Prism Release 2 Bug Ready For QA Normal map chart issues ALi RAZA 04/07/2026 06:30 AM

04/11/2026 5/18



# Project Tracker Status Priority Subject Assignee Updated

1417 Prism Release 2 Bug Ready For QA Normal Card Chart-> Data rent showing when chart is fully minimized ALi RAZA 04/07/2026 06:30 AM

1416 Prism Release 2 Bug Ready For QA Normal LINE AND AREA CHART ISSUSE ALi RAZA 04/07/2026 06:30 AM

1415 Prism Release 2 Bug Ready For QA Normal Setting Dropdown overlapping issue against all charts if the column name is

long

ALi RAZA 04/07/2026 06:30 AM

1414 Prism Release 2 Bug Ready For QA Normal Charts Setting-> Legends Title Customization-> Full title is not showing on

tool tip

ALi RAZA 04/07/2026 06:30 AM

1413 Prism Release 2 Bug Ready For QA Normal visual section----> series labels----> no space for labels---> background color mirza asad 04/07/2026 06:30 AM

1412 Prism Release 2 Bug Ready For QA Normal visual section----> markers---->color and border mirza asad 04/07/2026 06:30 AM

1411 Prism Release 2 Bug Waiting for Regression Normal visual section---> series labels---->option--->maximum width Maryam Farooq 03/27/2026 06:42 AM

1410 Prism Release 2 Bug Waiting for Regression Normal line chart line styling with color change on specific part (line style change) Maryam Farooq 03/27/2026 06:56 AM

1409 Prism Release 2 Bug Waiting for Regression Normal filter card -> text -> text size -> should limit 24px Maryam Farooq 03/27/2026 06:56 AM

1408 Prism Release 2 Bug Waiting for Regression Normal show tooltip on trunckat of chart title Maryam Farooq 03/27/2026 07:21 AM

1407 Prism Release 2 Bug Ready For QA Normal border color of bar/column mirza asad 04/07/2026 06:30 AM

1406 Prism Release 2 Bug Ready For QA Normal bar /column/line styling issues (this issue fix for all bar , column & line charts) ALi RAZA 04/07/2026 06:30 AM

1405 Prism Release 2 Bug Ready For QA Normal tool tip of 100 stacked area chat isn't working. mirza asad 04/07/2026 06:30 AM

1404 Prism Release 2 Bug Waiting for Regression Normal Sankey chart issues Maryam Farooq 03/27/2026 07:21 AM

1403 Prism Release 2 Bug Ready For QA Normal series labels issues (line chart, line & clustered column chart) mirza asad 04/07/2026 06:30 AM

1402 Prism Release 2 Bug Ready For QA Normal legend issuse ALi RAZA 04/07/2026 06:30 AM

1401 Prism Release 2 Bug Waiting for Regression Normal bubble chart issues Maryam Farooq 03/27/2026 09:14 AM

1400 Prism Release 2 Bug Ready For QA Normal Radar chart-> Value arent showing accuratly mirza asad 04/07/2026 06:30 AM

1399 Prism Release 2 Bug Ready For QA Normal 100% Stacked Area Chart – Visual and General Issues in Arabic & English UI ALi RAZA 03/27/2026 11:31 AM

1398 Prism Release 2 Bug Ready For QA Normal Union Tool - Analytics ALi RAZA 04/07/2026 06:30 AM

1397 Prism Release 2 Bug Waiting for Regression Normal Sankey chart issuse. mirza asad 03/27/2026 06:09 AM

1396 Prism Release 2 Bug Waiting for Regression Normal Sankey chart issuse mirza asad 03/27/2026 06:23 AM

1395 Prism Release 2 Bug Ready For QA Normal radar chat issuse mirza asad 04/07/2026 06:30 AM

1394 Prism Release 2 Bug Ready For QA Normal x axis label responsive issue  04/07/2026 06:30 AM

1393 Prism Release 2 Bug Ready For QA Normal Font families that are merged between alphabets.( for hole visualization

section)

mirza asad 04/07/2026 06:30 AM
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1392 Prism Release 2 Bug Waiting for Regression Normal card chart issuse. mirza asad 03/25/2026 10:51 AM

1391 Prism Release 2 Bug Ready For QA Normal space handling of total labels, has to fix ALi RAZA 04/07/2026 06:30 AM

1390 Prism Release 2 Bug Waiting for Regression Normal GERNAL -------> tooltip------>text---->values---->color is not applying on

values.

Maryam Farooq 03/25/2026 10:23 AM

1389 Prism Release 2 Bug Waiting for Regression Normal GERNAL------>properties ----> padding ----->bottom ----->is not working. Maryam Farooq 03/25/2026 10:23 AM

1388 Prism Release 2 Bug Waiting for Regression Normal GERNAL ----> add character limit on title text box minimum 20 maximum 40. Maryam Farooq 03/25/2026 10:23 AM

1387 Prism Release 2 Bug Ready For QA Normal legends ---> text----> title size & legends values , get  merged while

increasing text size.(IN ALL CHARTS)

ALi RAZA 04/07/2026 06:30 AM

1386 Prism Release 2 Bug Ready For QA Normal bubble chart issues mirza asad 04/07/2026 06:30 AM

1385 Prism Release 2 Bug Waiting for Regression Normal bubble chart issues Maryam Farooq 03/25/2026 11:12 AM

1384 Prism Release 2 Bug Waiting for Regression Normal bubble chart issues Maryam Farooq 03/25/2026 11:34 AM

1383 Prism Release 2 Bug Ready For QA Normal bubble chart issues mirza asad 04/07/2026 06:30 AM

1382 Prism Release 2 Bug Ready For QA High bubble charts issues mirza asad 04/07/2026 06:30 AM

1381 Prism Release 2 Bug Ready For QA Normal Stacked Area Chart – Visual and General Issues in Arabic & English UI ALi RAZA 03/27/2026 05:19 AM

1380 Prism Release 2 Bug Ready For QA Normal Area Chart – Visual and General Formatting Issues (Arabic & English

Interfaces)

ALi RAZA 03/27/2026 11:08 AM

1379 Prism Release 2 Bug Waiting for Regression Normal Auto field-Boolean Data Type isnt reflecting in metadata Ghulam Mustafa 03/26/2026 12:25 PM

1378 Prism Release 2 Bug Waiting for Regression Normal Charts are getting overlapped while drag chart on canvas ALi RAZA 03/25/2026 11:15 AM

1377 Prism Release 2 Bug Waiting for Regression High Incorrect aggregation functions displayed for Input Tool in Visualization

across all chart types

Maryam Farooq 03/25/2026 11:41 AM

1376 Prism Release 2 Bug Waiting for Regression Normal Line Chart Formatting Issues in Arabic and English Interfaces Maryam Farooq 03/25/2026 10:23 AM

1362 Prism Release 2 Bug Waiting for Regression Normal Chart styling or labels appear when the user reduces the chart size by

dragging.

Maryam Farooq 03/25/2026 12:09 PM

1360 Prism Release 2 Bug Waiting for Regression Normal Radar chart -----> category labels ----> background transparency isn't working

properly.

Maryam Farooq 03/25/2026 10:23 AM

1359 Prism Release 2 Bug Waiting for Regression Normal legends is missing in Sankey chart in prism but present in power bi Maryam Farooq 03/25/2026 10:24 AM

1358 Prism Release 2 Bug Waiting for Regression Normal tooltip isn't working properly of Sankey chart Maryam Farooq 03/25/2026 12:09 PM

1357 Prism Release 2 Bug Waiting for Regression Normal Sankey chart to radar chart field merging issue Maryam Farooq 03/25/2026 10:24 AM
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1356 Prism Release 2 Bug Ready For QA Normal reset button that appears on Sankey chart should be enlarge for better

visibility for user and also show 3second dialog massage that reset button

setting is now on.

ALi RAZA 04/07/2026 06:30 AM

1355 Prism Release 2 Bug Waiting for Regression Normal data labels------> display units field is missing in prism Maryam Farooq 03/25/2026 10:24 AM

1354 Prism Release 2 Bug Waiting for Regression Normal Sankey chart issuse. Maryam Farooq 03/25/2026 12:20 PM

1353 Prism Release 2 Bug Waiting for Regression Normal default setting should apply on pie & donut chart mirza asad 03/25/2026 11:10 AM

1352 Prism Release 2 Bug Waiting for Regression Normal pie and donut chart issuse mirza asad 03/25/2026 11:11 AM

1351 Prism Release 2 Bug Waiting for Regression Normal label name changing. mirza asad 03/25/2026 11:01 AM

1350 Prism Release 2 Bug Waiting for Regression Normal all three bubble chart are not working mirza asad 03/25/2026 11:12 AM

1349 Prism Release 2 Bug Waiting for Regression Normal card chat Maryam Farooq 03/25/2026 12:20 PM

1348 Prism Release 2 Bug Waiting for Regression Normal gridlines of chart Maryam Farooq 03/17/2026 10:53 AM

1347 Prism Release 2 Bug Waiting for Regression Normal horizontal chart---> y axis labels get marge with the charts bars. Maryam Farooq 03/17/2026 10:54 AM

1346 Prism Release 2 Bug Ready For QA Normal full data labels isn't coming on x-axis. ALi RAZA 04/07/2026 06:30 AM

1345 Prism Release 2 Bug Waiting for Regression Normal input tool data----> isn't showing proper visualization on chats Ghulam Mustafa 03/27/2026 06:30 AM

1344 Prism Release 2 Bug Waiting for Regression Normal while refreshing the visualization canvas ,data file is not refresh on chart,

pervious chart data keep on showing.

Maryam Farooq 03/25/2026 01:45 PM

1343 Prism Release 2 Bug Todo Normal show as blank as field in data labels---> data labels (isn't showing any results

on chart)

Muneeb  Shafqat 03/25/2026 01:42 PM

1342 Prism Release 2 Bug Waiting for Regression Normal Horizontal Bar Chart – Visual and General Formatting Issues in Arabic and

English Interfaces

Maryam Farooq 03/25/2026 01:45 PM

1341 Prism Release 2 Bug Waiting for Regression Normal 100% Stacked Column & Clustered Column – Visual and General Formatting

Issues (Arabic & English Interfaces)

Maryam Farooq 03/25/2026 01:45 PM

1340 Prism Release 2 Bug Waiting for Regression Normal tranparency effect both color of bar & border of bars Maryam Farooq 03/26/2026 10:38 AM

1339 Prism Release 2 Bug Waiting for Regression Normal yaxis--> title---> styling of title option not shows any result on chart. mirza asad 03/25/2026 12:50 PM

1338 Prism Release 2 Bug Waiting for Regression Normal filter section -----> top N filter----> show items input field should be blank  by

default

mirza asad 03/25/2026 12:49 PM

1337 Prism Release 2 Bug Waiting for Regression Normal grid line over lapping the y-axis values Maryam Farooq 03/26/2026 10:38 AM
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1336 Prism Release 2 Bug Ready For QA Normal range  , when user add minimum lower value then maximum value, instead of

show data on chart, no data pop-up will appear but in power-bi all the data will

shown on chart.

mirza asad 04/07/2026 06:30 AM

1335 Prism Release 2 Bug Waiting for Regression Normal x/y axis type continuous/categorical isn't  work as power bi, in categorical --->

the data that present in values field of chart that will show on chart, in

continuous---> plat should equally divide data in part's and then show on

chart

Maryam Farooq 03/27/2026 09:14 AM

1334 Prism Release 2 Bug Ready For QA Normal data labels distribution on x&y axis is not according to the data like (0 --

10k--20k--30k)

mirza asad 04/07/2026 06:36 AM

1333 Prism Release 2 Bug Waiting for Regression Normal bubble chart isn't working Maryam Farooq 03/17/2026 10:54 AM

1332 Prism Release 2 Bug Waiting for Regression Normal when all tabs closed on visualization the labels are not that much visible on

dark theam

mirza asad 03/26/2026 08:55 AM

1331 Prism Release 2 Bug Waiting for Regression Normal back to report button and chart header border is n't properly visible on dark

theam.

Maryam Farooq 03/26/2026 10:32 AM

1330 Prism Release 2 Bug Waiting for Regression Normal Filters-TopN- isnt match with powerBI ALi RAZA 03/25/2026 11:20 AM

1329 Prism Release 2 Bug Waiting for Regression Normal legends going inside if y-axis labels is long mirza asad 03/25/2026 12:58 PM

1328 Prism Release 2 Bug Waiting for Regression Normal Filters->Advance Filter- is blank, is not blank isnt working ALi RAZA 03/25/2026 11:22 AM

1327 Prism Release 2 Bug Waiting for Regression Normal data labels hiding in line chart from top side mirza asad 03/25/2026 08:12 AM

1326 Prism Release 2 Bug Waiting for Regression Normal marks should show inner data if one column mirza asad 03/26/2026 08:51 AM

1325 Prism Release 2 Bug Waiting for Regression Normal shade area should color as same of color parts if different color in one line

appling.

Maryam Farooq 03/26/2026 10:36 AM

1324 Prism Release 2 Bug Waiting for Regression Normal shade area if one data column should show inner data. mirza asad 03/25/2026 10:21 AM

1323 Prism Release 2 Bug Waiting for Regression Normal if one data column ,than color should apply on all. Maryam Farooq 03/26/2026 10:35 AM

1322 Prism Release 2 Bug Waiting for Regression Normal [x-axis & y-axis ]title unit not working mirza asad 03/26/2026 08:21 AM

1321 Prism Release 2 Bug Waiting for Regression Normal line color not applying mirza asad 03/26/2026 08:11 AM

1320 Prism Release 2 Bug Waiting for Regression Normal plot area background not display accurately in line chart mirza asad 03/25/2026 08:01 AM

1319 Prism Release 2 Bug Waiting for Regression Normal data labels should not display on bar if his length greater than bar size. mirza asad 03/26/2026 08:41 AM

1318 Prism Release 2 Bug Waiting for Regression Normal in column chart/ line column  chart----> y axis take 2 data column , if drag

from x-axis

mirza asad 03/25/2026 08:07 AM
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1317 Prism Release 2 Bug Waiting for Regression Normal Filters->Advance Filter-AND, OR function isnt working with string column ALi RAZA 03/25/2026 11:23 AM

1316 Prism Release 2 Bug Waiting for Regression Normal Filters->Advance Filter-AND function isnt working with numeric column ALi RAZA 03/25/2026 12:04 PM

1315 Prism Release 2 Bug Waiting for Regression Normal line column chart---> line chart /area chart, line y-axis -----> secondary y-axis

,even legends present its worng.

mirza asad 04/07/2026 06:37 AM

1314 Prism Release 2 Bug Waiting for Regression Normal area chart [x-axis, y-axis & secondary y-axis]data column, switch to bubble

chart , y-axis 2 data column are incorrect

mirza asad 03/26/2026 07:21 AM

1313 Prism Release 2 Bug Waiting for Regression Normal gridline transparencyis not Appling of only line column chart & horizontal bar

chart

Maryam Farooq 03/17/2026 10:54 AM

1312 Prism Release 2 Bug Waiting for Regression Normal visual sequence in pie /donut chart mirza asad 03/25/2026 07:46 AM

1311 Prism Release 2 Bug Waiting for Regression Normal in line chart /area chat visual data label sequence in correct mirza asad 03/25/2026 12:20 PM

1310 Prism Release 2 Bug Ready For QA Normal column chart y-axis going inside zoom slider after his font size increase. ALi RAZA 04/07/2026 06:30 AM

1309 Prism Release 2 Bug Waiting for Regression Normal plot area background image going outside  the right box Maryam Farooq 03/17/2026 10:54 AM

1308 Prism Release 2 Bug Waiting for Regression Normal x-axis , y-axis---> layout not working Maryam Farooq 03/17/2026 10:54 AM

1307 Prism Release 2 Bug Waiting for Regression Normal legends, x-axis , y-axis title, labels size increase decrease with chart size

increase decrease.

mirza asad 04/07/2026 06:37 AM

1306 Prism Release 2 Bug Waiting for Regression Normal bar chart --->  y-axis value maximum width 50% not functional Maryam Farooq 03/17/2026 10:54 AM

1305 Prism Release 2 Bug Waiting for Regression Normal column chart visual ----> x-axis ----> value ----> maximum bar height bar chart

working is should not winking by default 25%

Maryam Farooq 03/17/2026 10:55 AM

1304 Prism Release 2 Bug Waiting for Regression Normal charts x-ais labels issues in bar chat vs horizontal. mirza asad 04/07/2026 06:37 AM

1303 Prism Release 2 Bug Waiting for Regression Normal gridline color should some light Maryam Farooq 03/17/2026 10:55 AM

1302 Prism Release 2 Bug Waiting for Regression Normal visual styling ----> space between x-axis labels & x-ais value. Maryam Farooq 03/17/2026 10:55 AM

1301 Prism Release 2 Bug Waiting for Regression Normal visual styling ----> space between title & is more Maryam Farooq 03/17/2026 10:56 AM

1300 Prism Release 2 Bug Waiting for Regression Normal chart space b/w border and y-axis label is more. mirza asad 03/24/2026 08:02 AM

1299 Prism Release 2 Bug Waiting for Regression Normal Visual styling-------> visual lagend ------> title (only show title input field) Maryam Farooq 03/17/2026 10:56 AM

1297 Prism Release 2 Bug Waiting for Regression Normal General setting---> (rest to default  button) not Appling (properties (size &

position))

Maryam Farooq 03/17/2026 10:56 AM
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1296 Prism Release 2 Bug Waiting for Regression Normal General setting-----> propertis ----> padding ----> top increase ,x-ais label

move dwon side.

Maryam Farooq 03/17/2026 10:56 AM

1295 Prism Release 2 Bug Waiting for Regression Normal General setting-----> tooltip----> text----> drill text and icon should remove Maryam Farooq 03/17/2026 10:56 AM

1294 Prism Release 2 Bug Waiting for Regression Normal General setting---->effect ---> background color transparency isn't applying on

complete chart.

Maryam Farooq 03/17/2026 10:56 AM

1293 Prism Release 2 Bug Waiting for Regression Normal In Sankey series chart -> Scale Settings the reset button for this option not

working.

Maryam Farooq 03/26/2026 09:07 AM

1292 Prism Release 2 Bug Waiting for Regression Normal In Radar chart -> Category labels background transparency is not working. Maryam Farooq 03/26/2026 10:37 AM

1291 Prism Release 2 Bug Waiting for Regression Normal In Pie/Donut -> (Slices) when i using the specific field from the apply settings

to option and then using all so then the specific one remains unchanged.

Maryam Farooq 03/17/2026 10:56 AM

1290 Prism Release 2 Bug Waiting for Regression Normal Pie/Donut chart when user create that chart so the data labels should be by

default active same as power bi.

Maryam Farooq 03/17/2026 10:56 AM

1289 Prism Release 2 Bug Waiting for Regression Normal In the Card Chart there is an Callout Value in formatting section need to fix

that issue there is validation on the Decimal Places Field for user just able to

put the 0-4 value.

Maryam Farooq 03/17/2026 10:57 AM

1288 Prism Release 2 Bug Waiting for Regression Normal Filter hide icon tooltip have the issue with ar and en both lang. Maryam Farooq 03/17/2026 10:57 AM

1287 Prism Release 2 Bug Waiting for Regression Normal Filter cards option do not not working with the filter cards need to handle it

correctly and make sure the whole filter cards option should be working as

expected.

Maryam Farooq 03/26/2026 10:37 AM

1286 Prism Release 2 Bug Waiting for Regression Normal when we download the picture in png so the border is also around the picture

the canvas border which we are just showing in the visualization canvas

border need to fix it. (in both png and pdf also)

Maryam Farooq 03/26/2026 10:37 AM

1285 Prism Release 2 Bug Waiting for Regression Normal The sidebars of visualizations are not resizable by user need to fix that issue. Maryam Farooq 03/17/2026 10:57 AM

1284 Prism Release 2 Bug Waiting for Regression Normal Filter Pane -> Background the transparency option is missing need to fix that

issue.

Maryam Farooq 03/26/2026 10:37 AM

1283 Prism Release 2 Bug Waiting for Regression Normal Filter pane -> Search box option not working correctly. Maryam Farooq 03/26/2026 10:36 AM

1282 Prism Release 2 Bug Waiting for Regression Normal Filter pane -> input the input box color not working as expected need to fix it. Maryam Farooq 03/26/2026 10:36 AM

1281 Prism Release 2 Bug Waiting for Regression Normal In canvas setting -> Filter Pane -> Text the text color and icon color not

working as expected need to fix it.

Maryam Farooq 03/26/2026 10:33 AM

1280 Prism Release 2 Bug Waiting for Regression Normal At the bottom side of the wallpaper there is an extra spaces which is not

handled by the wallpaper formatting.

ALi RAZA 03/26/2026 10:22 AM

1279 Prism Release 2 Bug Waiting for Regression Normal In the Canvas Setting the Wallpaper the image/file upload button is not

visually looks correct need to be enhance it because its looks like a text field

but once we are click on it so then we are able to know oh its file upload field.

Both in light and da

Maryam Farooq 03/17/2026 10:57 AM
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1278 Prism Release 2 Bug Waiting for Regression Normal Same issue with the Wallpaper issue as well like i deslect it bur even after

that still able to change the wallpaper color and the toggle of the wallpaper

automatically on once i change the bg color.

Maryam Farooq 03/17/2026 10:57 AM

1277 Prism Release 2 Bug Waiting for Regression Normal Even when we are deactivate the toggle button of canvas background so still

able to change the background color fix that issue once the user deactivate

the radio button so the under the canvas background there is nothing to

usable.

Maryam Farooq 03/17/2026 10:57 AM

1276 Prism Release 2 Bug Waiting for Regression Normal In the canvas settings -> Canvas Background -> Image upload button is not

looks like a file upload button its just look like a text field so that' why we have

to fix that issue and make sure that there should be a icon with it also just for

user guidance

Maryam Farooq 03/17/2026 10:58 AM

1275 Prism Release 2 Bug Waiting for Regression Normal Remove the Alt text formatting option in the general styling because that is

not useable in the Prism right now.

Maryam Farooq 03/17/2026 10:58 AM

1274 Prism Release 2 Bug Waiting for Regression Normal In the General Styling -> data Format -> format options the "Scientific"

Formatter not working as expected need to fix it.

ALi RAZA 03/25/2026 12:22 PM

1273 Prism Release 2 Bug Waiting for Regression Normal In the General Styling -> data Format -> format options the currency need to

remove the "Israeli New Shekel".

ALi RAZA 03/25/2026 12:24 PM

1272 Prism Release 2 Bug Waiting for Regression Normal In the General Styling -> data Format -> format options the "thousands

separator" is not working need to fix it.

ALi RAZA 03/25/2026 12:26 PM

1271 Prism Release 2 Bug Waiting for Regression Normal In the General Styling -> Effect -> Shadow there is missing option in the

position the missing option is custom, like user will control the shadow as per

requirements.

ALi RAZA 03/25/2026 12:31 PM

1270 Prism Release 2 Bug Waiting for Regression Normal when the user increased the visuals border width so the header option from

right or the chart title from left getting cut off.

ALi RAZA 03/26/2026 10:28 AM

1269 Prism Release 2 Bug Waiting for Regression Normal when the chart have large dataset so the color picker getting lag even with

only 1000 records.

Maryam Farooq 03/27/2026 11:31 AM

1268 Prism Release 2 Bug Waiting for Regression Normal there is no consistency between the whole page's components like the font

size, font weight like that.

Maryam Farooq 03/26/2026 10:35 AM

1267 Prism Release 2 Bug Ready For QA Normal Visualization getting lag with the large dataset need to fix that issue because

that is our core priority to give users best user experience.

ALi RAZA 04/07/2026 06:30 AM

1266 Prism Release 2 Bug Waiting for Regression Normal The navigation bar canvas control buttons zoom out and zoom in options not

translate in Arabic so fix it.

Maryam Farooq 03/17/2026 10:58 AM

1265 Prism Release 2 Bug Waiting for Regression Normal On visualization canvas when we have two charts so we are getting the

visuals guidelines but we also want the guidelines against the canvas as well.

Maryam Farooq 03/26/2026 10:38 AM

1264 Prism Release 2 Bug Waiting for Regression Normal when user increase the size of the visual/chart border so the x-axis getting cut

of the title.

ALi RAZA 03/26/2026 10:16 AM

1263 Prism Release 2 Bug Waiting for Regression Normal General styling -> Title -> Divider -> missing two options "Space Below Title"

and "Space below subtitle".

Maryam Farooq 03/26/2026 10:44 AM

1262 Prism Release 2 Bug Waiting for Regression Normal By default chart title do not have the background color once user will applied

it then it will be applied on the chart

Maryam Farooq 03/26/2026 10:45 AM

1261 Prism Release 2 Bug Ready For QA Normal Where we have the text formatting there we do not have the options of

underline and italic text styling so need to implement it.

ALi RAZA 04/07/2026 06:30 AM
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1260 Prism Release 2 Bug Waiting for Regression Normal when we create chart small so make sure the chart's graph will be visible hide

the other things on the chart.

Maryam Farooq 03/26/2026 10:45 AM

1259 Prism Release 2 Bug Waiting for Regression Normal We have the Alt text option in the general tab which is not working need to fix

it.

Maryam Farooq 03/17/2026 10:58 AM

1258 Prism Release 2 Bug Waiting for Regression Normal in the data format option of general setting the thousand separator not

working .

Maryam Farooq 03/26/2026 10:56 AM

1257 Prism Release 2 Bug Waiting for Regression Normal in the general styling the header option there is lot of icons remove all extra

icons

ALi RAZA 03/26/2026 10:49 AM

1256 Prism Release 2 Bug Waiting for Regression Normal In the 100% stacked area chart and 100% stacked column and bar chart

remove the display unit option from the x-y-axis.

ALi RAZA 03/26/2026 10:58 AM

1255 Prism Release 2 Bug Waiting for Regression Normal when i activate the series label there is a lot of space at the right side of them. Maryam Farooq 03/26/2026 11:11 AM

1254 Prism Release 2 Bug Waiting for Regression Normal When i make changes in the series label with specific field and then use all

option so the previous background remains unchanged on the series label fix

it.

Maryam Farooq 03/26/2026 11:43 AM

1253 Prism Release 2 Bug Waiting for Regression Normal In the Markers option the "Minus sign" is not same as power bi so need it

same as power bi.

Maryam Farooq 03/26/2026 11:43 AM

1252 Prism Release 2 Bug Waiting for Regression Normal when i change the background color so i see the title section remains

unchanged this is also a part of chart.

Maryam Farooq 03/26/2026 11:43 AM

1251 Prism Release 2 Bug Waiting for Regression Normal i want In the general -> Title -> subtitle the text i want the subtitle text in it and

user will update it accordingly.

ALi RAZA 03/25/2026 09:55 AM

1250 Prism Release 2 Bug Waiting for Regression Normal While moving the chart title to the right it getting cutting off at the back of the

header options.

Maryam Farooq 03/26/2026 11:43 AM

1249 Prism Release 2 Bug Waiting for Regression Normal In the general -> Title the text i want the title text in it and user will update it

accordingly

ALi RAZA 03/26/2026 11:45 AM

1248 Prism Release 2 Bug Waiting for Regression Normal Total label are getting cut off while in the 100% stacked area chart. Maryam Farooq 03/26/2026 12:08 PM

1247 Prism Release 2 Bug Waiting for Regression Normal In the line formatting the apply settings to option is not working with

layout.remove it sitwch axis of lines

Maryam Farooq 03/26/2026 12:08 PM

1246 Prism Release 2 Bug Waiting for Regression Normal Scatter with trendline by default have a extra zoom slider need to remove it. Maryam Farooq 03/27/2026 09:14 AM

1245 Prism Release 2 Bug Waiting for Regression Normal The bubble/3D bubble charts are not reflecting the correct logic of the charts

need to be check because i am not able to create bubble chart visuals with

different type of data.

Maryam Farooq 03/26/2026 12:09 PM

1244 Prism Release 2 Bug Waiting for Regression Normal Total labels are not reflecting on the Bar and columns charts. Maryam Farooq 03/18/2026 06:10 AM

1243 Prism Release 2 Bug Waiting for Regression Normal Remove the Ribbons from the Clustered and Clustered column chart Maryam Farooq 03/26/2026 12:09 PM

1242 Prism Release 2 Bug Waiting for Regression Normal In the focus mode the chart title should same as report one. Maryam Farooq 03/26/2026 12:25 PM
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1241 Prism Release 2 Bug Waiting for Regression Normal In the focus mode my x-axis getting cut off. Maryam Farooq 03/18/2026 06:28 AM

1240 Prism Release 2 Bug Waiting for Regression Normal why the title and the value of the data label the formatting are getting merge

they should be work as individually same as power bi, do not change any

thing from one of them and the other one auto change.

ALi RAZA 03/26/2026 08:46 AM

1239 Prism Release 2 Bug Waiting for Regression Normal Data Labels -> Title -> Content the percent of total not working,(Fix it or

Remove it, as it is not available in Power BI.)

Maryam Farooq 03/26/2026 12:25 PM

1238 Prism Release 2 Bug Ready For QA Normal Data labels are not working correctly with the positions so need to fix it ALi RAZA 04/07/2026 06:30 AM

1237 Prism Release 2 Bug Waiting for Regression Normal Apply Settings of ribbons are not working need to fix that issue ALi RAZA 03/25/2026 10:12 AM

1236 Prism Release 2 Bug Waiting for Regression Normal Ribbons are not showing correctly need to fix it. (when toggle of from the

legend so the ribbon should also be hide.)

ALi RAZA 03/26/2026 07:14 AM

1235 Prism Release 2 Bug Ready For QA Normal when zoom slider and legend have the same positioning so then there is still

overlapping issue between the values of x-axis and zoom sliders labels.

ALi RAZA 04/07/2026 06:30 AM

1234 Prism Release 2 Bug Waiting for Regression Normal Transparency of the Gridlines horizontal and vertically not working. Maryam Farooq 03/27/2026 11:31 AM

1233 Prism Release 2 Bug Waiting for Regression Normal The legend title should also be truncate at the certain point to better user

experience.

ALi RAZA 03/26/2026 12:18 PM

1232 Prism Release 2 Bug Waiting for Regression Normal In the title's X-axis and Y-axis do not show me the existing value they have

they just show me blank input field need to show the existing values between

it so user change it accordingly.

ALi RAZA 03/25/2026 10:01 AM

1231 Prism Release 2 Bug Waiting for Regression Normal Y-axis getting overlapped with legend when we have the big title need to be

handle it.

ALi RAZA 03/27/2026 10:29 AM

1230 Prism Release 2 Bug Waiting for Regression Normal Y-axis title should be truncate at the certain place according to the available

space for it.

ALi RAZA 03/18/2026 06:42 AM

1229 Prism Release 2 Bug Waiting for Regression Normal On reset to default (global one) button should be confirmation popup warning

like you want to make sure reset every single formatting on the chart like this.

ALi RAZA 03/18/2026 06:27 AM

1228 Prism Release 2 Bug Waiting for Regression Normal At the sidebar of Visualization Tab the icons for visuals and formatting need

to be created related because right now that are irrelevant.

ALi RAZA 03/18/2026 06:22 AM

1227 Prism Release 2 Bug Waiting for Regression Normal If user move the y-axis labels and title using switch axis option so the space

still showing on the default place of axis.

ALi RAZA 03/18/2026 06:25 AM

1226 Prism Release 2 Bug Waiting for Regression Normal The positioning of the legend's is not working as expected ALi RAZA 03/25/2026 10:15 AM

1225 Prism Release 2 Bug Waiting for Regression Normal - Legend Overlapping issues still happening need to handle it more correctly. ALi RAZA 03/25/2026 10:05 AM

1224 Prism Release 2 Bug Waiting for Regression Normal Dropdown of drop areas boxes/fields there is a localization issue (Remove

Field)

ALi RAZA 03/17/2026 10:21 AM

1223 Prism Release 2 Bug Waiting for Regression Normal 100% Stacked Bar Chart – Visual and General Formatting Issues (Arabic &

English Interfaces)

ALi RAZA 03/18/2026 05:42 AM
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1222 Prism Release 2 Bug Waiting for Regression Normal Clustered Column Chart – Visual and General Formatting Issues (Arabic &

English Interfaces)

ALi RAZA 03/17/2026 10:52 AM

1221 Prism Release 2 Bug Waiting for Regression Normal Visualization UI issue on Line and clustered column Chart ALi RAZA 03/25/2026 11:25 AM

1220 Prism Release 2 Bug Waiting for Regression Normal Visualization -Selected chart should get highlighted with on top ALi RAZA 03/25/2026 11:26 AM

1219 Prism Release 2 Bug Waiting for Regression Normal Visualization- Map chat shouldn't showing any result until the data set is

accurate

ALi RAZA 03/25/2026 11:34 AM

1218 Prism Release 2 Bug Waiting for Regression Normal Visualization Charts-> Bubble Scater, Bubble 3D, Scatter Trend Line Chart

isnt working in prism

ALi RAZA 03/17/2026 09:40 AM

1216 Prism Release 2 Bug Waiting for Regression Normal Visualization -no results are showing in any chart if the dataset has any blank

or null values

ALi RAZA 03/25/2026 11:30 AM

1215 Prism Release 2 Bug Ready For QA Normal Analytics - Input Data Tool ALi RAZA 04/07/2026 06:30 AM

1214 Prism Release 2 Bug Waiting for Regression Normal Visualization - Table View Maryam Farooq 03/26/2026 12:24 PM

1213 Prism Release 2 Bug Waiting for Regression Normal Clustered Bar Chart Formatting Issues in Arabic and English Interfaces ALi RAZA 03/17/2026 10:48 AM

1212 Prism Release 2 Bug Waiting for Regression Urgent Y-axis labels are migrating with the chart, and incorrect data values are

distributed on the x-axis. HORIZONTAL CHART

Maryam Farooq 03/27/2026 06:41 AM

1211 Prism Release 2 Bug Waiting for Regression Urgent The blue highlight disappears after all charts are selected from the canvas.

The blue highlight disappears after all charts are selected from the canvas.

Add corner arrows to the chart, similar to Power BI, which appear when the

chart is selecte

mirza asad 03/26/2026 12:12 PM

1210 Prism Release 2 Bug Waiting for Regression Urgent Chat border is invisible in the visualization canvas's light theme. mirza asad 03/26/2026 12:06 PM

1209 Prism Release 2 Bug Waiting for Regression Normal Stacked Column Chart – Visual and General Formatting Issues (Arabic &

English Interfaces)

ALi RAZA 03/18/2026 05:30 AM

1208 Prism Release 2 Bug Ready For QA Normal Stacked Bar Chart ALi RAZA 04/07/2026 06:30 AM

1188 Prism Release 2 Bug Waiting for Regression Urgent X-Axis/Y-Axis labels are not distributed into equal sections across charts

compared to Power BI behavior

ALi RAZA 04/07/2026 06:37 AM

1187 Prism Release 2 Bug Waiting for Regression Urgent card chart issues mirza asad 03/27/2026 10:20 AM

1186 Prism Release 2 Bug Waiting for Regression Normal cards issues Fareena Anayat 03/17/2026 10:08 AM

1185 Prism Release 2 Feature Todo Normal Model View Feature of Visualization Ghulam Mustafa 04/07/2026 12:59 PM

1184 Prism Release 2 Feature Todo Normal Table View Feature of Visualization Ghulam Mustafa 04/07/2026 12:59 PM

1183 Prism Release 2 Bug Ready For QA Normal Large File uploading should be properly implemented on prism Ghulam Mustafa 04/07/2026 06:36 AM

1182 Prism Release 2 Feature Todo Normal Prism Dashboard Template Feature Ghulam Mustafa 04/07/2026 12:59 PM
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1181 Prism Release 2 Bug Waiting for Regression Urgent scroll bar show on to x-axis label in all column chart Fareena Anayat 03/17/2026 09:55 AM

1180 Prism Release 2 Bug Waiting for Regression Urgent same column in one drop area by drop  and drop from area. mirza asad 04/07/2026 06:37 AM

1179 Prism Release 2 Bug Waiting for Regression Urgent Zoom slider resets when chart is moved. mirza asad 04/07/2026 06:37 AM

1178 Prism Release 2 Bug Waiting for Regression Urgent in all chart---> legends not scrolling 1/3 Fareena Anayat 03/17/2026 09:36 AM

1177 Prism Release 2 Bug Waiting for Regression Urgent series label---> font size maximum 24, also check for every front size change

field in visualization section.

mirza asad 04/07/2026 06:37 AM

1176 Prism Release 2 Bug Waiting for Regression Urgent The filter/resize/three-dot icon should not be visible in demi chart data. mirza asad 04/07/2026 06:37 AM

1175 Prism Release 2 Bug Waiting for Regression Urgent all charts---> secondary -y-axis or legends any one add only mirza asad 04/07/2026 06:37 AM

1174 Prism Release 2 Bug Waiting for Regression Urgent Filter section search bar background color mismatch. mirza asad 04/07/2026 06:37 AM

1173 Prism Release 2 Bug Waiting for Regression Urgent Data section/visualization section /filter header height mismatch. mirza asad 04/07/2026 06:37 AM

1172 Prism Release 2 Bug Waiting for Regression Urgent The font family in the filter section differs from the font family used in the

visualization section.

mirza asad 04/07/2026 06:37 AM

1171 Prism Release 2 Bug Waiting for Regression Urgent In dark theme, text color is inconsistent, with some text appearing white and

some gray.

mirza asad 04/07/2026 06:37 AM

1170 Prism Release 2 Bug Waiting for Regression Urgent Fix extra spacing inside the legend  in chart mirza asad 04/07/2026 06:37 AM

1169 Prism Release 2 Bug Waiting for Regression Urgent Chart's three-dot (:) section doesn't auto-close. mirza asad 04/07/2026 06:37 AM

1168 Prism Release 2 Bug Waiting for Regression Urgent The "reset to default" button's UI is inconsistent across the canvas, general,

and visual settings.

mirza asad 04/07/2026 06:37 AM

1167 Prism Release 2 Bug Waiting for Regression Normal Auto field ALi RAZA 03/17/2026 09:36 AM

1166 Prism Release 2 Bug Waiting for Regression Normal Visualization - deleted all on back space ALi RAZA 04/07/2026 06:37 AM

1165 Prism Release 2 Bug Waiting for Regression Normal Visualization -fiter icon should get hide automatically ALi RAZA 04/07/2026 06:37 AM

1164 Prism Release 2 Bug Waiting for Regression Normal Visualization general Setting -> Dark Theme issue ALi RAZA 04/07/2026 06:37 AM

1163 Prism Release 2 Bug Waiting for Regression Normal visulaization->Canvas screen is getiing overlapped ALi RAZA 04/07/2026 06:37 AM

1162 Prism Release 2 Bug Waiting for Regression Normal My work flow-> Delte isnt working and theme issue ALi RAZA 03/17/2026 09:36 AM
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1161 Prism Release 2 Bug Waiting for Regression Normal Top nav bar of analytics screen->Edit ALi RAZA 03/17/2026 09:35 AM

1160 Prism Release 2 Bug Waiting for Regression Normal Dark Theme issue on Dashboard ALi RAZA 04/07/2026 06:37 AM

1147 Prism Release 2 Bug Waiting for Regression Urgent Decimal Places option not working for Values in X/Y Axis in Visualization

section

Ghulam Mustafa 04/07/2026 06:37 AM

1133 Prism Release 2 Bug Waiting for Regression Urgent Improper handling of null and negative data values across all charts in

Visualization section

Maryam Farooq 03/27/2026 11:32 AM

1132 Prism Release 2 Bug Waiting for Regression Urgent Charts and Legends activation in Visualization Row section are not

independent

Maryam Farooq 03/27/2026 11:32 AM

1082 Prism Release 2 Bug Todo Urgent Date issue from backend. Ghulam Mustafa 03/09/2026 06:58 AM

1057 Prism Release 2 Bug Todo Urgent Auto Tool assigns incorrect data type (Int16) to Year field in Analytical

section, causing incorrect visualization output

Ghulam Mustafa 03/09/2026 06:58 AM

1036 Prism Release 2 Bug Waiting for Regression Urgent Donut Chart Value Ghulam Mustafa 04/07/2026 06:37 AM

1035 Prism Release 2 Bug Todo Normal Connection between Analytics and Visualization ALi RAZA 03/09/2026 06:58 AM

1003 Prism Release 2 Bug Todo High Fuzzy Match Tool – Merge (Only Records from a Different Source are

Compared) results do not match Alteryx and throws “Invalid match type(s)”

error in Prism

Ghulam Mustafa 03/09/2026 06:58 AM

1002 Prism Release 2 Bug Todo Normal Fuzzy Match Tool – Japanese Match Style Options Missing in Prism (Join

Section → Analytical Canvas)

Ghulam Mustafa 03/09/2026 06:58 AM

1001 Prism Release 2 Bug Todo High Fuzzy Match Tool results mismatch between Prism and Alteryx at 50% Match

Threshold

Ghulam Mustafa 03/09/2026 06:58 AM

961 Prism Release 2 Bug Waiting for Regression Urgent Card Chart does not display multiple Values fields simultaneously when

multiple Category fields are added (Behavior mismatch with Power BI)

ALi RAZA 04/07/2026 06:37 AM

960 Prism Release 2 Bug Waiting for Regression Urgent Categories Field Missing for Card Chart in Prism Visualization (Available in

Power BI)

ALi RAZA 04/07/2026 06:37 AM

956 Prism Release 2 Bug Ready For QA High Bubble / Scatter Chart in Prism does not match Power BI output when using

identical dataset and field configuration

ALi RAZA 04/07/2026 06:36 AM

955 Prism Release 2 Bug Waiting for Regression Normal Visualization - Visual - Data Labels Maryam Farooq 03/27/2026 11:31 AM

941 Prism Release 2 Bug Todo High Data Field “Add Data” option and Detail section missing in Visual Settings of

charts (Prism)

Muneeb  Shafqat 03/09/2026 06:58 AM

933 Prism Release 2 Bug Ready For QA Normal Unable to update data file on prism canvas ALi RAZA 04/07/2026 06:30 AM

930 Prism Release 2 Bug Todo High “Concatenate Labels” option for X & Y axis values does not work in Prism

charts

ALi RAZA 03/09/2026 06:58 AM

929 Prism Release 2 Bug Waiting for Regression Normal All Tools-> Error messages isnt cleared Ghulam Mustafa 03/27/2026 07:20 AM

909 Prism Release 2 Bug Ready For QA Normal Line chart transparency color is not applied correctly in Prism ALi RAZA 04/07/2026 06:36 AM
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# Project Tracker Status Priority Subject Assignee Updated

894 Prism Release 2 Bug Waiting for Regression High Boolean data type shows incorrect aggregation functions compared to Power

BI

ALi RAZA 03/26/2026 12:05 PM

853 Prism Release 2 Bug Ready For QA Normal All the chart legend Maryam Farooq 04/07/2026 06:36 AM

844 Prism Release 2 Bug Waiting for Regression High Aggregation Function for Boolean Data Type Not Displayed Correctly on

Visualization Canvas

ALi RAZA 03/26/2026 12:03 PM
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